
HEALTH RESEARCH ETHICS BOARD 

INFORMED CONSENT FORM (ICF) TEMPLATE



Instructions to Researcher

· This is a template that contains a combination of suggested wording and instructions for content. 

· Instructions and guidance are provided in blue, italicized font. Definitions can be found in HREB Application Guidance. 

· Prior to submission, delete everything in blue italicized font unless the wording is required for your study ( the first page of the participant-facing Informed Consent Form (ICF) should start with the Island Health logo (page 3 will be page 1 when you have the finished document).

· If you are conducting a clinical study (involves an invasive clinical procedure, investigative drug, or medical device), please use the BC Clinical Research Informed Consent Form Guide and Template https://www.islandhealth.ca/research-capacity-building/research-ethics-approvals/forms-templates

· If you have a UBC affiliation, or this research involves another health authority or post-secondary institution, this research ethics application should be submitted to https://www.rise.ubc.ca/ 

· Note that you must properly identify the type of data you are collecting throughout all study documents:

Data Definitions:

· De-identified Data/Coded Data: Does not contain any personally identifiable information. Study code numbers or pseudonyms are used in place of participant names.

· Anonymized Data: Personally identifiable information was collected, but has now been irrevocably destroyed; no linking of data to participants is possible.

· Anonymous Data: No identifiers were ever collected. Researchers do not know who participants are.

· [bookmark: _GoBack]If you have any questions, contact the Research Ethics & Compliance Office at 250 519 6726.


Formatting Information:
· Font size should be a minimum of 12 and use minimum 1.5 spacing between rows; Depending on your study population, consider using a larger font size.
· Ensure that you use simple, lay language (aim for grade 8). Use the readability and level statistics in Word to assess (1.Go to File > Options; 2.Select > Proofing; 3.Under “When correcting spelling and grammar in Word”, make sure to check “Mark grammar errors as you type” 4.Select “Show readability statistics”; Hit “OK” 5. On the Word ribbon (top of page) Go to Review > Select “ABC Spelling and Grammar” to see readability statistics.
· Spell out acronyms at first use.
· Avoid technical terms or jargon.
· Number the pages. 
· The consent form should be written in the second person. Use ‘you’ not ‘I’. However, first person or ‘I’ should be used on the last page in the ‘Signatures’ section. 
· Proof read prior to submission for typographical errors and grammar.
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ENTER STUDY TITLE HERE

PARTICIPANT INFORMATION & CONSENT FORM


PRINCIPAL INVESTIGATOR AND STUDY TEAM:

Principal Investigator (PI) Name and Affiliation/Title:
Address:
Phone Number:
Email: 

If the study includes a Co/Sub-Investigator or Research Coordinator/Assistant that will be directly interacting with research participants, include their names, titles (for example Research Assistant, Research Coordinator), institutional affiliations, and contact numbers.


___________________________________________________

Background and Purpose of the Study
You are being invited to participate in a research study. You may choose whether or not to participate: the choice is entirely up to you and you cannot be required to participate if you do not want to do so (this is known as free and voluntary consent). The purpose of this study is to: 

Briefly state the background and purpose of the project in lay terms. Describe why the project is important and the contributions it hopes to make.


Sub-Studies 
Sometimes a research project will recruit a subgroup of participants from the current study to perform other research activities. If you are part of this subgroup, you will be provided with another consent form describing the new research activities and requesting your consent. If not applicable to your research, delete sub-study section including “Sub-Studies” heading.


You are being asked to participate in this study because you: 

Inclusion Criteria: 

Exclusion Criteria: 
Provide a description using Inclusion and Exclusion criteria to describe how people may or may not meet the study’s participation requirements. You can use a bulleted list or present it in sentences. Note: the age of majority in BC is 19 years of age.

Location of Research
This research study will be conducted
Include the location or locations where the study will be conducted.

Number of Participants
Insert number participants will be included in this study, including insert number participants from this region.

Project Funding
This project is being funded by include the full name of the study funder, granting agency, sponsor, or scholarship if applicable.  If not funded, exclude this entire section, including the heading “Project Funding”

You may ask the PI for any information with regard to this if you have any questions. 

What is Required to Participate?
If you decide to participate in this study, you will describe the participant-related activities during the study; include description and number of interviews, surveys, etc., number of visits, time required per visit and total time for participation in the study.  Please list research activities in the order that the activities occur. You may use bullet points, a chart/figure, or table – whichever format is best for participants to understand.

You have the right to skip answering any question. You have the right to stop your participation in the study at any point. You may stop your participation in the study without providing a reason to the researcher.

If information is to be accessed, collected, and shared from the participants’ health or client record, briefly state it here and then state see “Confidentiality & How my Personal Information will be Used” section on Page # for more details.

Example: “For details about how information about you will be accessed, collected, used, or shared, see the section “Confidentiality & How my Personal Information will be Used” section on Page #.

For studys that include different activities at different time points, consider presenting the information in table format or diagram format. This may be easier for participants to understand.

Research Involving Patients (if applicable)
For studies that involve patients, describe what is different between participating in the study and routine care.



Research Involving Staff (if applicable):
Describe the research activities that differ from the daily activities of staff including the time commitment, and location where the research activities will occur. For staff-participant research, state whether the research activities will occur on work time or personal time. Note that if others (Directors or Managers) are aware of the staff member participating in the research, that you must identify this as a “Limit to Confidentiality” to participants. 

Interviews or Surveys (if applicable):
Describe the nature of the information/data to be collected as part of the interview or survey.  Include a couple of example questions so that participants are fully informed as to what to expect. 

If a survey is involved, include a statement that the participant can decline to answer any question, should they choose. If some questions are mandatory, this should be explicitly stated so that the participant can decide whether to participate or not.

Focus Groups/Group Activities/World Café (etc.) (if applicable): 
Describe the nature of the information/data to be collected as part of the focus group/group activity/World Cafe. Include a few example questions  

Please note: While focus group participants will be requested to maintain confidentiality related to all discussions, confidentiality cannot be guaranteed due to the nature of group-related research activities.

What are the Possible Risks or Inconveniences of Participating? 
You may be exposed to the following risks and inconveniences:
Describe all relevant risks (e.g. physical, psychological, social), Describe any risks to communities (e.g. stigmatization, discrimination, etc.). Consider consulting any groups that may be affected by the research to assess the risk of negative impacts such as stigmatization and discrimination. 

Inconveniences should also be stated (e.g. distance to travel, etc.) 
 
To reduce these risks, the following steps will be taken:
Describe how the risks will be mitigated or addressed.

What are the Possible Benefits of Participating?
The possible benefits of your participation include:
Consider/state benefits to the participant and possible future benefits to others in similar circumstances, as well as generally advancing knowledge in the field. It is important not to overstate the benefits of the research or promise direct benefits to participants when unlikely or unknown.

Do You Have to Take Part?
Research Involving Patients (if applicable)
Include the following: 
You are free to choose to participate or not. If you decide not to participate, your regular health care or service will not be affected in any way. By consenting, you have not waived any rights to legal recourse connected to research-related harm. If you do decide to participate and then change your mind later, you can withdraw without any consequences or explanation.  If you do withdraw from the study, we will ask you if we can still use your collected data. 


Research Involving Staff (if applicable):
Include the following: 
You are free to participate or not. If you decide not to participate, your employment status will not be affected in any way. By consenting, you have not waived any rights to legal recourse connected to research-related harm. If you do decide to participate and then change your mind later, you can withdraw without any consequences or explanation.  If you do withdraw from the study, we will ask you if we can still use your collected data. 

Will You be Paid for Taking Part?
Payment, financial or otherwise, should be clearly outlined on the consent form. Payment should not be dependent on completion of the project, but can be pro-rated for those who withdraw before completion.

If funding is available to cover the costs of out of pocket expenses such as travel, parking, child care cost, include the following:
We will reimburse any costs that you incur as a result of participating in this research study including: specify transit, travel, parking, child care costs, if applicable.  If you decide to withdraw early, we will still reimburse you for the costs you incur up until your withdrawal date. 

Studies that will acknowledge participation with a stipend or gift etc. include the following:
As a way to thank you for your time and participation, you will be given specify what will be given as a thank you, if applicable. Delete entire line if not applicable. This is not meant to influence your decision to participate. 

Studies that will not reimburse or provide a stipend etc.  Include the following:
You will not be provided with any payments or coverage of costs for participating in this study.

Researcher’s Relationship with Participants
Researchers: You must clearly declare if you have a Dual Role or are in a Power-Over role with participants.

Dual Role: When the researcher has a pre-existing relationship with participants (i.e. a physician who is conducting research with patients; a manager who is conducting research with employees, employees conducting research with colleagues), this relationship must be explicitly declared in the Informed Consent Form and steps to mitigate this role must be outlined to participants.

Power-Over role: Any relationship where the researcher has some kind of power over the participant. This Power-Over may be used unintentionally or intentionally to influence an individual to be recruited or participate in a research activity that they would not otherwise participate in if there was no power influencing their decision making. This relationship must be explicitly declared in the Informed Consent Form and steps to mitigate this must be outlined to participants.

As the researcher this is from the perspective of the Principal Investigator, I am a specify the dual role/relationship to some participants, if applicable i.e. colleague, employer, therapist, doctor, teacher of some participants. To help prevent my relationship from influencing your decision to participate, the following steps have been taken:
Describe steps taken to mitigate any power-over relationships or any other ethical issues.  

Add similar statements if applicable to Co-Investigators or other team members.

Delete entire section, including the heading, if this is not applicable.

On-Going Consent
Each unique research activity will require your ongoing consent.

Confidentiality & How Your Personal Information will be Used
If identifiable or potentially identifiable information is to be accessed, collected, used or shared from the participants or from their health or client record the following must be clearly stated:

· How the participant’s information will be accessed, collected, used and shared;
· All types of information being accessed, collected, used, and shared (Make sure that the information that you include here MATCHES exactly what you state you are collecting in your protocol. If it does not, questions will be raised by Island Health’s REB and by Information Stewardship, Access & Privacy Office);
· Who will have access to the participant’s information;
· Where the information is being accessed and/or collected from (e.g., your Island Health health record, your Island Health electronic health record);
· Who the information will be shared  with (if it is being shared) and for what purposes  (example: the  ________ Research team at the University of British Columbia will code, analyze, and report the data).
· If personal information is being coded/de-identified or anonymized at any point, describe when and how it will be de-identified or anonymized (e.g., if it is being coded/de-identified after it leaves Island Health, this must be clearly stated to the participant). Include a statement that identifies if any linkages are being made (if applicable) between the participants’ information at Island Health and other sources of information about them.
· The date that the consent to collect their personal information expires, include the following:
Your consent to collect your information for the purpose of this research project will expire when you complete the study.
· If information is being stored or accessed from outside of Canada, participants must explicitly consent to it and be informed of what country it is being stored in or accessed from, the name of the organization, the purpose that it is being sent to that country and be notified that laws in that country may differ from those in BC and Canada with respect to how their information is accessed, collected, used and shared. Use suggested wording below if applicable:

The data collected on you for this research project will be stored in the [enter name of country] at [enter name of organization] for the purpose of [enter reason]. For information that is stored or accessed from outside of Canada, Canadian & BC privacy laws may not apply and it is possible that your information could be accessed without your knowledge or consent by that country’s government or other organizations in accordance with their laws (e.g., the USA Freedom Act, formally known as the Patriot Act in the United States).

Studies involving Focus Groups and Interviews:
If an interview or focus group will be audio-taped or video-taped, include a statement with this information and details on who will complete the transcription and when the tape will be destroyed.  Include special precautions taken to protect the security/confidentiality of video-tapes.

Include a statement that for participants who choose to withdraw after they begin focus group activities; it will be logistically impossible to remove individual data from a group session.

Include a statement that “While focus group participants will be requested to maintain confidentiality of all focus group discussions, confidentiality cannot be guaranteed.”


Future Use of Data
Include a statement about future use of the research data, if it is retained and not destroyed at the conclusion of the study. Describe potential future use(s) and that consent will be requested. 

If the data will be anonymized at the conclusion of the study resulting in the inability to re-contact for purposes of consent, include this statement.

Disposal of Data
Your data from this study will be disposed of in the following manner: (examples included for illustrative purposes only, please fill in information specific to your study)

	Data Source
	How Destroyed
	When Destroyed

	Digital documents
	Permanently destroyed (double deleted)
	These will be retained for XX (number) years after study completion. (if applicable: “This is required by my funding agency”.)

	Paper notes/data
	Confidentially shredded
	Immediately following transcription

	Interview notes
	Confidentially shredded
	These will be retained for XX (number) years after study completion. (if applicable: “This is required by my funding agency”.)



Sharing of Study Results
A summary of the study results will be provided to you upon request. (remove if not applicable)

The study results will be published and presented to (provide details on dissemination of study results. Include possible website address. Remove entire sentence if not applicable)

Commercial use of Results
This research may lead to a commercial product or service. (If applicable, describe the relationship to the investigator and research team members. Delete section, including the heading, if not applicable) 

Who Should You Contact if You Need More Information About the Study?
The contact information for the Principal Investigator is provided on the first page of this Informed Consent Form.
 
Include the research coordinator or other study team member who will serve as a contact for participants as well by including the name, and telephone number/email address if applicable.

Contact for Complaints
For complaints about your rights as a research participant, please contact the Island Health Research Ethics and Compliance Office in Victoria at (250) 519-6726 or email: ResearchEthics@viha.ca.

CONSENT

My signature below indicates that:
1. All sections of this Informed Consent Form (ICF) have been explained to my satisfaction
2. I understand the requirements, potential risks, benefits, and responsibilities of participating in the research project, and;
3. I understand how my information will be accessed, collected and used.
4. I understand that I can withdraw any any time;
Researchers: ensure you state if data can or cannot be withdrawn
5. All of my questions have been fully answered by the researchers.


	

	
	 
	
	

	Name of Participant
	
	Signature 
	
	Date


                   (print)




A blank Informed Consent Form (ICF) may be emailed out to participants, but participants should not be emailing back a signed ICF. 

Doing so may pose a threat to the confidentiality and privacy of participants. 

Researchers who email out blank ICFs, typically collect and log the oral/verbal consent of participants.

If written consent negatively impacts the participant’s welfare, or poses a threat to their confidentiality, ICFs do not need to be signed – verbal consent may be collected. 

If collecting verbal consent at the start of the interview or focus group, adjust the “signature” line on page 10 to read “verbal consent”. 

If appropriate, create a consent log (collecting name, date and time verbal consent was collected, and name of inidivudal collecting consent.) 

A consent log may not be appropriate in all cases if this poses a threat to partiiapnt confidentiality. Consent may be inferred by the participation of the individual. 















One copy for you.

One copy for the researcher.
Version date: (Update the version date each time the form is revised.)	Page  2 of 7
Version date + date (e.g V1 24 Oct 2020): 
Update the version date each time this form is updated and a new version is submitted to the REB.	Page  11 of 11
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